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1. APARATURA

Na raspolaganju su sljede¢i uredaji i oprema:
* Xilinx ISE v.10.1 (ili v.14.7)
®* SPARTAN-3E Starter Kit razvojna platforma
® Serijski (null-modem) kabal
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2. TEORIJSKA OSNOVA LABORATORIJSKE VJEZBE

Ova laboratorijska vjezba koristi UART Real-Time Clock dizajn, a detaljne informacije se
mogu naci u fajlu UART_real_time_clock.pdf koji je sastavni dio PicoBlaze distribucije.

Dizajn implementira Real-Time Clock (Casovnik u realnom vremenu) koji se brine o
vremenu izraZenom u satima, minutima i sekundama i koji ima moguénost podeSavanja alarma.
Casovnik i alarm se pode$avaju i vrijeme se prikazuje posredstvom serijske komunikacije (UART),
pomoc¢u jednostavnih tekstualnih komandi/poruka, preko bilo kojeg terminal programa
(hyperterminal, PuTTY, ...)

Dizajn prepoznaje neke jednostavne ASCII komande i ¢ak podrZava editovanje istih u toku
njihovih unoSenja koriS¢enjem tastera <Backspace> na tastaturi. Komande se zavrSavaju pritiskom
tastera <ENTER> tj. kada se poSalje ASCII kod za ,,carriage return*. Dizajn je spreman da prihvati
novu komandu kada je prikazan prompt , KCPSM3>“.

Casovnik je u stanju da interpretira komande zadate i velikim i malim slovima, i to tako §to
¢e ih prije analiziranja konvertovati u velika slova (za detalje pogledati dokumentaciju). Izdavanje
neispravne komande ¢e rezultirati porukom ,,Synfax error, a zadavanje neispravne vrijednosti
vremena porukom ,,Invalid time*. “Overflow error poruka ¢e se pojaviti ako se komande izdaju
brZe nego §to ih dizajn moZe procesuirati.

Dizajn zahtjeva taktni impuls frekvencije 55MHz. Budu¢i da Spartan-3E platforma ima
oscilator frekvencije S0MHz, koristi¢e se Architecture Wizard da bi se generisao Digital Clock
Manager (DCM) sa izlaznim signalom od S5MHz i instancirao unutar dizajna.
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3. ZADACI LABORATORIJSKE VJEZBE

Ova demonstracija ukljucuje 4 glavna koraka:
» koriS¢enje Architecture Wizard-a da bi se konfigurisao DCM,;
* instanciranje DCM-a u Verilog dizajn;
» koris¢enje PACE-a da bi se signalima pridruzili pinovi Cipa i implementirao dizajn, i
na kraju
* testiranje dizajna na hardveru.

KoriS¢enje Architecture Wizard-a za konfigurisanje DCM-a

Treba otvoriti postojeci projekat.

1. Ako je ISE Project Navigator zatvoren, odabrati:
Start —» Programs — Xilinx ISE Design Suite 10.1 — Project Navigator

2. lzabrati File — Open Project u Project Navigator-u.

3. Prona¢i putanju do fajla arwz_pace.ise i izabrati ga.
Napomena: ako se koristi ISE Design Suite 14.7 onda u Open Project prozoru treba
izabrati opciju ,,0ld ISE Project Files (*.ise)“, jer novije verzije programa koriste drugaciju
formu projektnog fajla, sa ekstenzijom .xise.

4. Kliknuti <Open>.

Napomena: ukoliko se pojavi poruka da je projekat kreiran sa ranijom verzijom razvojnog
okruZenja i da je potrebno izvrsiti konverziju, kliknuti <Yes>.

Ovoj verziji dizajna nedostaje DCM komponenta. Za konfigurisanje DCM komponente da na
izlazu generiSe taktni signal frekvencije SSMHz koristi se Architecture Wizard.

5. U Processes for Source prozoru, dva puta kliknuti na Create New Source
Ukoliko se u prozoru ne nalazi Create New Source, treba provjeriti da li je HDL izvorni fajl
u Sources prozoru.
Napomena: ako se koristi ISE Design Suite 14.7 onda izabrati Project = New Source.

6. U New Source prozoru treba odabrati IP (CoreGen & Architecture Wizard) i kao naziv
fajla unijeti my_dcm.

7. Kliknuti <Next>.

8. U slede¢em prozoru (slika 1) treba otvoriti FPGA Features and Design = Clocking -
Spartan-3E, Spartan-3A i odabrati Single DCM SP v8.2i (odnosno verziju koja je prisutna
u tekucoj verziji ISE).
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E MNew Source Wizard - Select IP

" [ Automotive & Industrial

- (EBasic Elements

-- [ Communication & Metworking

-- [ Digital Signal Processing

Ela FPGA Featurez and Deszsign

=-£3 Clocking

=-£5 Spartan-3E, Spartan-34

2 Board Degkew with an Intermal Deskew [DCM SP) v3.20
2 Cazcading in Senies with Two DCM 5P +8.2
% Clack, Forwarding # Board Deskew [DCK 5P +3.21

- 2+ Clack: Switching with Two DCM 5Pz w84

# Single DCM 5P 820

" [CIMath Functions
-- [ Memaries & Storage Elements

Slika 1. Architecture Wizard Selection Box

9. Potom se klikne na <Next>, a zatim <Finish>. (Ako se koristi ISE Design Suite 14.7 onda u
prozoru koji ¢e se pojaviti kliknuti <OK>.)
10. U Xilinx Clocking Wizard — General Setup prozoru, treba odabrati sledece opcije (kao na
slici 2):
o CLKO, CLKFX I LOCKED boxes: Checked
RST box: Unchecked
o Input Clock Frequency: 50 MHz

Xilinx Clocking Wizard - General Setup

v
-
r
-
I
r
r
v
-
-
PSEN r
PSINCDEC v
PSCLK
— Input Clock Frequency Phaze Shift
MG MHe s Type: [NOKE = |
Walue; ID j 0.000 ns 0.000 Degrees
—CLEIM Source ——————————————— |~ Feedback Source
' Euternal 7 Intemal " External & Intemnal © None
 Single = Single
© Differertial £ Differential
—Dide By Walie———————————  Feedback Yalue
|2 vI i« 1% 2%
¥ Use Duty Cycle Correction
Advanced... | More Info |
< Back I Mext > I Cancel |

Slika 2. Xilinx Clocking Wizard
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11. Kliknuti na <Next>.

12. U Xilinx Clocking Wizard — Clock Buffers prozoru (Slika 3) zadrZe se podrazumijevane

vrijednosti i klikne na <Next>.

Xilinx Clocking Wizard - Clock Buffers

— Clack Buffer Setting

* ze Global Buffers for all selected clack outputs

" Cugtomize buffers

Input 10

Input 11

Yiew/E dit Butfer |

CLKO

Global Buffer |

CLKZ4

Giobal Buffer |

Slika 3. Xilinx Clocking Wizard — Clock Buffers Window

13. U Xilinx Clocking Wizard - Clocking Frequency Synthesizer dijalogu treba unijeti
55MHz u polju za izlaznu frekvenciju (Slika 4) i potom kliknuti <Next>, a zatim <Finish>.

Napomena: Ukoliko my_dcm.xaw fajla nema u hijerarhiji dizajna, onda ga korisnik treba

dodati na Project > Add Source.

E# Xilinx Clocking Wizard - Clock Frequency Synthesizer

Dz Mode
Lo
High

Inputs for Jitter Calculations

(=) Use output frequency

Calculate

Generated Output

Yalid Ranges for Speed Grade -4

|nput Clock Frequency: 50000 kMHz

M D

1 10

Fin (MHz]
0,200 - 333.000

0,200 - 333.000

5 ) MHz () ns
) Uze Multiply [M] and Divide [ walues
M (4 (N

Fout [MHz]
5.000 - 326.000

5.000 - 333.000

Dutput Penod Jitter [umt Penod Jitter
Freq [MHz] interval] [pk-to-pk ns)
005 nss

Slika 4. PodeSavanje izlazne frekvencije kod DCM-a

Treba primijetiti da je dodat novi fajl (my_dcm.xaw) kao Source u projektu (slika 5). Ovaj
Source fajl nece biti ukljucen u hijerarhiju dizajna dok komponenta ne bude instancirana u jedan od

HDL Sourse fajlova.
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Sources

Sources for: | Synthesis/lmplementation
\=| anwz_pace
= £79 »c3sh00e-4fg320
= ﬁmﬂuart_clock [uart_clock. v
processzor - kepsmd (kepsmd.v]
program_rom - uclock [UCLOCEK. Y]
# instance_namne - my_dem [my_dom,xaw]
= transmit - wark_ts [uart_kw.w)
kouart - kouart_ts [kouart_tw.v)
buf_0 - bbfifo_16x8 [bbfifo_1Ex8.v)
= recelve - uart_rs [uart_rs.v)
kcuart - kouart_m [kouart_n ]
buf_00 - bhfifo_16x8 [bhfifo_1Ex8 )
@ uart_clock.ucf [uart_clock.uck)

Slika 5. DCM je prikazan u Sources prozoru

Instanciranje DCM-a u Verilog dizajnu

Sada kada su kreirani neophodni fajlovi, DCM komponenta se moZe instancirati unutar
dizajna. Treba prekopirati tekst iz Instantiation Template u uart_clock.v i povezati signale.

1. Selektovati my_dcm.xaw i dva puta kliknuti na View HDL Source u Processes for Source
prozoru, da bi se ispitao Source code kreiran od strane Architecture Wizard-a.

Ako se fajl ne pojavi u tekst editoru, potrebno je ponovo dva puta kliknuti na View
HDL Source.

Ovaj fajl sadrzi sledece instancirane komponente: IBUFG, DCM, i dva BUFG-a.
Ulazni clock CLKIN_IN upravlja sa IBUFG, koji je povezan sa DCM-om. Dva izlazna
clock-a rade na BUFG komponentama.

Svi DCM parametri su proslijedeni posredstvom Verilog meta-comments-a.

2. U Sources prozoru, dva puta kliknuti na uart_clock.v da bi se otvorio izvorni kod u tekst
editoru.

3. Izabrati my_dcm.xaw u Sources prozoru.

4. U Processes for Source prozoru dva puta kliknuti na View HDL Instantiation Template
da bi se otvorio $ablon za instanciranje u tekst editoru.

Ako se Sablon ne pojavi u tekst editoru, opet treba dva puta kliknuti na View HDL
Instantiation Template.

5. Iz Sablona za instanciranje (fajl my_dcm.tfi) kopirati modul za instanciranje i insertovati ga
u uart.clock.v ispod komentara ,,// Insert DCM component declaration here*.

6. Instanciranje zavrSiti povezivanjem portova sa signalima na sljede¢i nacin:



Laboratorijska vjeZba 2 Architecture Wizard i PACE Lab

my_dcm inst_my_dcm (
.CLKIN_IN(clk),
.CLKFX_OUT(clk55MHz),
.CLKIN_IBUFG_OUT(),
.CLKO_OUTY(),

.LOCKED_OUT(lock)

);

Napomena: port clkin_ibufg_out je izlazni port koji podrzava dizajne koji koriste
RocketlO ™ transivere. PoSto ovdje ne koristimo Virtex-II Pro ¢ipove, ovaj port ¢e biti
povezan na dummy signal.

7. Dodati deklaraciju za izlazni signal DCM-a (55MHz), i to ispod komentara ,,// Signals for
DCM*:

wire clk55MHz;

Napomena: uart_clock.v dizajn je ve¢ izmijenjen na nacin da su svi taktni signali (clk)
preimenovani da odgovaraju novom taktu (clkSSMHz).

8. Dodati izlazni pin lock u modul najveceg nivoa kao $to je prikazano:

module vart_clock

( tx,
X,
alarm,
clk,
lock);

output tx;

input rx;
output alarm;
input clk;

output lock;

Napomena: izlazni pin lock upravlja LED1 diodom na Spartan-3E platformi, a on sam je
upravljan od strane lock signala DCM-a. Na ovaj nacin se korisniku signalizira da je DCM
uspjeSno povezan sa taktnim signalom frekvencije SOMHz iz oscilatora sa razvojne
platforme.

9. Izabrati File>Save.

Primijetiti da je fajl my_decm.xaw sada postavljen na pravu poziciju u hijerarhiji dizajna.

Koris¢enje programa PACE za pridruZivanje pinova

Kod ve¢ine FPGA dizajna postoje zahtjevi za rasporedom pinova i prije nego se sam dizajn
zavr$i. PACE omogucava veoma lako pridruZivanje pinova i pruZa moguc¢nost provjeravanja da li
izabrani raspored pinova zadovoljava I/O standarde.

U ovoj vjezbi se koristi PACE da bi se u dizajnu signali pridruZili pinovima.

1. U Sources prozoru treba oznaciti dizajn najveceg nivoa uart_clock.v.
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2.

U prozoru Procesess, da bi se otvorio PACE, treba raSiriti User Constraints i dva puta
kliknuti na Floorplan IO — Pre-Synthesis. Kada se pokaZe poruka ,,Da li Zelimo da dodamo
UCEF fajl?*, treba kliknuti <YES>.

Napomena: ako se koristi ISE Design Suite 14.7 onda treba rasiriti User Constraints i dva
puta kliknuti na Floorplan Area/IO/Logic (PlanAhead). Kada se otvori prozor koji
postavlja upit da li Zelimo da automatski kreiramo UCF i dodamo u projekat treba kliknuti na
<Yes>. U paketu ISE Design Suite 14.7 program PACE je zamijenjen programom
PlanAhead.

Obratiti paZznju na Design Object List prozor i na listu signala. Primjetiti da je to lista
ulaznih i izlaznih portova datog dizajna. (Kod PlanAhead-a pogledati prozor I/O ports.)

U koloni Loc (kod PlanAhead-a koloni Site), pored svakog signala unijeti oznake pinova da
bi povezali dizajn sa Spartan-3E platformom, a potom sacuvati dizajn:

o clk  :povezati sa 50 MHz oscilatorom

o lock :povezatisaled0

o alarm : povezati sa led1

o 1X : povezati sa pinom koji prima serijske podatke iz ‘MAX3232’
o tx : povezati sa pinom koji salje serijske podatke do MAX3232

Napomena: Za raspored pinova pogledati Spartan-3E korisni¢ko uputstvo.

. U Device Architecture prozoru (slika 6) uvelicavati sve dok se jasno ne prikazu pojedinacni

pinovi. Obojena povrsina pored pinova oznacava koji pinovi pripadaju istoj I/O banci.

L[]

Slika 6. Device Architecture prozor
Kliknuti na neki obojeni I/O pin i odgovarajuci pin ce biti oznacen (selektovan) u Design
Object List (I/0 ports) prozoru.
Izabrati File->Save da bi se sacuvala podeSavanja.
Izabrati File->Exit da se zatvori PACE.

U prozoru Sources selektovati fajl uart_clock.ucf, rasiriti User Constraints u prozoru
Procesess i dva puta kliknuti na Edit Constraints (Text) da bi se vidjela pridruZivanja
kreirana preko programa PACE (PlanAhead).

Verifikovanje pridruzivanja pinova i startovanje terminal sesije

1. Selektovati fajl uart_clock.v u Sources prozoru.

U Processes prozoru rasiriti Implement Design proces, a potom i Place & Route.

3. Dva puta kliknuti na Pad Report. (Kod ISE Design Suite 14.7 raSiriti Back-annotate Pin

Locations i dva puta kliknuti na View Locked Pin Constraints.)
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Project Navigator automatski pokrece sve potrebne procese, i otvara izvjestaj ¢im se zavrsi
Place & Route proces.

4. Pogledati izvjestaj i uvjeriti se da su I/O signali povezani na pinove onako kako smo zadali.

Otvaramo hyperterminal sesiju na slede¢i nacin: Start - All Programs —>Accessories 2>
Communications - HyperTerminal

6. Dati proizvoljno ime sesiji, kliknuti <OK> i izabrati komunikacioni port (COM1).

Kliknuti na Configure i unijeti parametre kao na slici 7.

COM1 Properties

Part Settings |
Bitzs per second: 5_38400 :|
D ata bits: :8_ v'
Parity: i-i\lune vi
Stop bt |1 vl
Flaw contat. | [T~ |
Feztore Defaultz
[ OF l [ Cancel J [ Apply ]

Slika 7 Parametri za serijsku komunikaciju

8. Kliknuti na tab Settings, zatim na ASCII Setup i 'Strikirati' checkbox pored Append line feeds
to incoming line ends, a potom kliknuti <OK> jednom, a zatim jo§ jednom da bi izasli iz
datog prozora.
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! T —— "@'—'9,'.

| Connect To Settings |

Function, arow, and ctil keps act as

&) Teminal keys e

ASCII Setup

Backspace key sends A5CI Sending
@ ok O Del O [ Send line ends with line feeds
[1 Echo typed characters locally

Ernulation: - -
Auto detect e Line delay: |0 | millizeconds.
. ; Character delay: 0 | millizeconds.
Telnet terminal 1D |ANSI
Backscroll buffer lines: | 500 ASCH Reseiving
[] Play sound when connecti Append line feeds to incoming line ends

[1 Farce incoming data to 7-bit ASCI
Input Translation... ‘wiap lines that exceed terminal width

ak J I Carcel

L H J1 i Jl

Slika 8 PodeSavanja za ASCII

Upisivanje i testiranje dizajna

Treba generisati tzv. bitstream i upisati ga u FPGA c¢ip.

1.
2.

Povezati Spartan-3E platformu USB kablom sa raunarom, a zatim platformu ukljuéiti.

Selektovati uart_clock.v u Sources prozoru i dva puta kliknuti na Generate Programming
File u Processes prozoru da bi generisali bitstream koji ¢e se upisati u FPGA.

Kada je proces zavrSen, treba raSiriti Configure Target Device i dva puta kliknuti na
Manage Configuration Project iMPACT).

Izabrati Configure Devices using Boundary-Scan (JTAG), i kliknuti na <Finish>.

Napomena: Kada se pojavi dijalog Boundary-Scan Chain Contents Summary, samo treba
kliknuti <OK>.

Napomena2: Na 64-bintom window-su se moZe desiti da platforma ne bude prepoznata,
kada se radi sa 32-bitnim ISE Design Suite-om. U tom slucaju je potrebno ru¢no pokrenuti
64-bitni iMPACT program i dva puta kliknuti na Boundary Scan u Flows prozoru. Nakon
toga se desnim tasterom misa klikne na praznu bijelu povrsinu na kojoj piSe ,,Right click to
Add Device or Initialize JTAG chain* i izabere se opcija Initialize Chain.

Napomena 3: kod ISE Design Suite 14.7 treba dva puta kliknuti na Boundary Scan u
iMPACT Flows prozoru. Nakon toga se desnim tasterom miSa klikne na praznu bijelu
povrsinu na kojoj piSe ,,Right click to Add Device or Initialize JTAG chain‘ i izabere se
opcija Initialize Chain. Na pitanje ,,Do you want to continue and assign configuration
file(s)*“ odgovoriti sa <YES>.

Kada se pojavi dijalog Assign New Configuration File, izabere se uart_clock.bit fajl za
xc3s500e (prvi uredaj u JTAG ‘lancu’) i klikne se <Open>.

Napomena: ako se pojavi upozoravaju¢a poruka da je inicijalni clock promijenjen na
JTAG-ov, samo treba kliknuti <OK>.

Napomena 2: ako se pojavi pitanje ,,Do you want to attach an SPI or BPI PROM to this
device odgovoriti sa <No>.
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6. Za ostale uredaje, kliknuti Bypass.

7. Kada se pojavi prozor Device Programming Properties samo kliknuti <OK>. Izgled
radnog prozora prikazan je na slici 9.

TOI I ﬁ Exume Fxumy
*C32500e xofldz xc2chBda
uart_clock it ---file ¥ --- --- file 7 ---

TRCRCRCRCRC
el

TRCRCRCRCRC

TDO

Slika 9. JTAG lanac sa dodijeljenim konfiguracionim fajlom

8. Kliknuti desnim klikom na ikonicu ¢ipa xe3s500e koji je oznaCen zelenom bojom (ako nije
oznacen prvo ga selektovati lijevim tasterom miSa) u radnom prozoru i odabrati Program.

U ovom trenutku bi trebao da se vidi KCPSM3> prompt u hyperterminal prozoru, kao na
slici 10.

“& fpga_flow - HyperTerminal

Fle Edit Wiew Call Transfer Help
D& =3 D8
-~
KCPSM3>_
e
< >
Connecked 0:07:53 Auko detect 38400 §-H-1 LI

Slika 10. Serijska komunikacija sa Spartan 3E platformom

Rad sa UART Real-Time Clock-om

Slijede komande kojima se upravlja UART Real-Time Clock-om.

* Unijeti komandu ‘time’ da bi se prikazalo trenutno vrijeme u formatu hh:mm:ss (slika 11).
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“& fpga_flow - HyperTerminal E] E| PZ|

File Edit Wew Call Transfer Help
0O = A B
A~
KCPSM3> time
00:06:53
KCPSM3>
v
< ¥
Connected 0:13:51 Auko detect 35400 5-M-1 UM

Slika 11. Prikaz taCnog vremema

* Unijeti komandu ‘alarm’ da bi se dobio prikaz o trenutno postavljenom alarmu u formatu
hh:mm:ss (slika 12).

Napomena: Alarm je trenutno neaktivan.

“& fpga_flow - HyperTerminal

Fil= Edit Yiew Call Transfer Help

KCPSM3> time
00:06:53

KCPSM3>alarm
00:00:00
Alarm OFF
KCPSM3>

Slika 12. Prikaz alarma i njegovog statusa

e Da bi ukljucili alarm, unijeti komandu 'alarm on'.
* Da bi postavili alarm na 30 sekundi, unijeti komandu 'alarm 00:00:30'.
* Da bi podesili vrijeme, unijeti komandu 'time 00:00:00'.
Napomena: dioda LED1 ¢e se upaliti kada se alarm aktivira.
e Da bi se iskljucio alarm, unijeti komandu 'alarm off'.

Napomena: Kada se alarm deaktivira i LED1 se ugasi.
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4. ZAKLJUCAK



